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Although deadweight 
testers can be accurate 
if used properly (and it’s 
easy to make mistakes), 
each measurement can 
take a minute or more 
– so a 10 point calibration 
(10 points up and down) 
takes at least 20 minutes.  
With FastCalXP calibration 
system, you can do it in 2 
minutes!
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can be accurate if used prop-

erly (and it’s easy to make 

mistakes), each measurement 

can take a minute or more 

– so a 10 point calibration (10 

points up and down) takes at 

least 20 minutes.  With Fast-

CalXP calibration system, you 

can do it in 2 minutes!

To easily generate and set 

pressure precisely, use 

GaugeCalXP, a high pres-

sure (up to 10,000 PSI or 700 

bar) hydraulic comparator. 

GaugelCalXP is not limited to 

only oil as the hydraulic fluid 

(many deadweight testers 

require oil, only). You can use 

distilled water instead, or 

even isopropyl alcohol (IPA) 

with GaugeCalXP. (Warning: 

IPA dries quickly, but it is 

flammable) We also recom-

mend that you consider our 

range of quick connecting, 

leak free fittings that let you 

connect the gauges being 

tested (to the comparator) 

without the need for thread 

sealing tape, seals, or tools.
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Introduction

Thank you for purchasing (or trying) FastCalXP.  
FastCalXP is the cornerstone of a specially designed and easy 
to use pressure calibration system that helps you calibrate 
pressure gauges faster than you ever imagined. Whether you 
calibrate pressure gauges every day or only once in a while, 
FastCalXP saves you time, while helping you automate record 
keeping and reduce data entry errors.

Instead of using deadweight testers, FastCalXP was specifi-
cally designed to be used with Crystal Engineering prod-
ucts—pressure gauges and calibrators as the reference 
pressure standards (currently XP2, XP2i and 30 series calibra-
tors) and the GaugeCalXP pressure comparator for pressure 
generation and precise pressure control. 

FastCalXP was designed to run on Windows® XP or Windows 
2000. Calibration and instrument data are stored in a Micro-
soft Access® compatible database, but reports are created 
in the familiar Microsoft Excel® (*.xls) file format. If you know 
how to use Excel, you can have FastCalXP produce calibration 
certificates that look exactly like the format your company 
uses now (including logos and any other information). Just 
modify the included Excel template spreadsheet or create 
your own template files (You don’t need to know anything 
about Access.) 

Often, installing, configuring and managing other calibration 
software and databases is very difficult and can take a very 
long time. FastCalXP software is not only easy to use, it’s also 
very easy to set up—you can start to use it right away!

But read the following Installation and Quick Start sections 
for an overview of how FastCalXP works and for additional 
time saving tips and techniques to better use the software.

What FastCalXP Can Do For You
FastCalXP provides 

•	 Convenient storage of all pressure calibration-related data in a single database.

•	 Automatic detection of Crystal Engineering digital reference gauges and automatic reading 
and storage of pressure data.
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•	 Easy generation and storage of pressure test profiles.

•	 Flexible templates for certificate generation.

•	 Intuitive user interface for all calibration operations and data management.

How it Works
A typical installation of FastCalXP includes a personal computer running Windows 2000 or later, 
a GaugeCalXP comparator and an XP2i or Model 30 digital pressure gauge, used as the refer-
ence.  The device under test, or gauge, is mounted on the comparator along with the reference 
and the reference is connected to the computer’s serial port. 

FastCalXP stores detailed information about all tested or otherwise entered gauges, references 
and users as well as all acquired calibration for each gauge.  The flow of the program proceeds 
in four steps:

1	 Select Gauge Step

2	 As Received Step

3	 As Left Step

4	 Certificate Step

FastCalXP automatically detects a Crystal digital reference connected to the computer’s se-
rial port.  The software also automatically reads and records pressure measurements from the 
reference.

All of the information entered into or acquired by FastCalXP is stored in a single relational 
database using Microsoft Access components already on your computer.  Using the database, 
FastCalXP generates Microsoft Excel-compatible calibration certificates.

Using this Manual
To quickly get started with your FastCalXP software, read the Installation and Setup section, 
followed by the Quick Start section.  

More detailed sections on Calibrating Gauges, Creating Certificates, fine tuning Settings and 
Options, and Managing the Database follow the Quick Start.  

Also included in this manual are reference sections for Menus and Windows, Frequently Asked 
Questions and Pressure Calibration Terms.  Appendices include Appendix A: FastCalXP Pres-
sure Units and Appendix B: Excel Template Tags.

Additional sources of information include the GaugeCalXP Operator Instructions, the XP2i Digi-
tal Test Gauge Operation Manual, and the 30 Series Operation Manual.
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Installation and Setup

Included in your FastCalXP box is an installer CD, a CD key and an operation manual.  Also in-
cluded is a standard serial cable for use with a Crystal Engineering XP2i digital pressure gauge.  
An optional foot switch or RS232 to USB adapter may also be included.

System Requirements
FastCalXP is a Windows application.  No peripherals are required to run the software and man-
age the FastCalXP database.  However, a typical installation includes a pressure comparator 
and a digital pressure gauge, or reference, along with the computer on which FastCalXP will be 
installed.

�	Computer
FastCalXP requires a personal computer with a serial port, or USB port if using the RS232 to 
USB adapter.  An additional USB will be required if using the optional foot switch. Version 1.0 
is compatible with Windows 2000, XP or 2003.  In order to create certificates using FastCalXP, 
Microsoft Excel (or Office) 2000, XP or 2003 must also be installed.

�	Comparator
FastCalXP was designed to operate with a Crystal Engineering GaugeCalXP pressure compara-
tor.

�	Reference
For automatic reference detection and data acquisition, FastCalXP requires a Crystal XP2i or 
Model 30 digital pressure gauge connected via a serial cable to the computer.  The Model 30 
requires its own non-standard serial cable.  This cable can be ordered from Crystal Engineering 
as Crystal Part Number 1928.  

Ideally, the calibration station will include a range of references that will provide optimal accu-
racy over the pressure range of each of the models normally tested at the station.  Refer to the 
discussion of Reference Selection on page 12.

Hardware Setup and Connections
To set up your work station, position the GaugeCalXP next to the computer monitor and 
keyboard.  Be sure that your serial cable will reach from the reference mounted on the rear 
comparator position to the serial port of the computer.  Also, in some modes of operation, you 
may need to have one hand on the handle of the comparator and one hand on your computer 
keyboard or mouse.  



Page �   •   FastCalXP User’s Manual

If you have purchased the optional foot switch, plug the switch in to a USB port on your com-
puter.  Position the foot switch so that you will be able to operate it with your foot while you 
are operating the comparator with your hands.  Refer to the Using the Foot Switch discussion 
on page 20.

Refer to the GaugeCalXP Operator Instructions for help with setting up the comparator.

Software Installation
If you have downloaded the software from the Internet, simply run the downloaded execut-
able and follow the instructions to complete the installation. 

If you have an installation CD, insert the CD into the drive on your computer and setup will run 
automatically.  If setup fails to start, run the SETUP.EXE from the CD. Follow the instructions in 
setup to complete the installation.  

Quick Start

This section provides a summary of the four basic steps needed to complete a calibration using 
FastCalXP.  It is intended to get you quickly up and running upon installation and to provide a 
guide for the new user of an existing installation.

The four basic FastCalXP steps are displayed in the center of the main window and following 
the steps from left to right will get you through a calibration session.  At the completion of any 
step it is possible to return to any previous step using the back arrows.

Before attempting calibrations, verify that your work station is set up as described above.
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Set Up the Calibration
1	 Run FastCalXP.  After the initial installation, FastCalXP does not require a username or pass-

word.  However, if the Login option has been engaged, FastCalXP will prompt you for your 
username and password.

	

The first time FastCalXP is run after installation, the software will prompt you to locate the 
database or specify the name and location of a new database.

 You will also be prompted to select a location for the storage of certificates.

2	 Load the Gauge.  Lookup existing gauge or create a new gauge using the New Gauge Wiz-
ard.  The New Gauge Wizard will take you through the addition of a new gauge in four steps:

a	 Select or add a manufacturer.

b	 Select or add a model.  The New Model Wizard will take you through the process of add-
ing a new model in two steps:

•	 Enter model information.

•	 Select or build a test profile.  Refer to the discussion of Test Profiles on page 34.

c	 Select or add a location.  A location is not required.

d	 Enter information about the gauge.

Refer to the detailed discussion of the New Gauge Wizard on page 8.  

3	 Connect the gauge as described in the GaugeCalXP Operator Instructions.  



Page �   •   FastCalXP User’s Manual

4	 Choose a reference with appropriate accuracy.  For example, metrology guidelines suggest 
a four-to-one accuracy ratio of the reference to the gauge.  Refer to the discussion of Refer-
ence Selection on page 12 for more detail.

5	 Connect the reference as described in the GaugeCalXP manual.  Connect the serial cable to 
the reference and to the computer’s serial port.  By default, FastCalXP will look for the refer-
ence on the first serial port.  Refer to the Settings and Options section for help with chang-
ing the serial port.

Take the As Received Data
�	Perform a New Calibration.
1	 Click the Perform As Received Cal button.  

2	 The Calibration Wizard welcome page will be displayed. Click Next to auto-detect the refer-
ence as described in the discussion of References on page 12.  

If a new reference is detected, the Calibration Wizard will prompt you to enter the current 
certificate information for the reference.

3	 If the profile requires it, exercise the gauges by increasing and decreasing the pressure over 
the full range of the gauge one or more times.  Refer to the GaugeCalXP Operator Instruc-
tions or the discussion of Exercising gauges on page 15 for more information.

The Calibration Window will then open.  Refer to description of the Calibration Window in 
the Menus and Windows section.  

4	 Select Actual or Peak mode and step through the calibration.  Refer to the discussions of 
Calibration Strategies, Actual Mode Calibration and Peak Mode Calibration later in the 
manual.

5	 Save the calibration data.

�	Or Load Existing As Received Data.
If the As Received calibration has been completed in a previous session, complete the As Re-
ceived Step by clicking the Load Previous Data button.

Take the As Left Data
If the gauge failed the As Received calibration and adjustments have been made to the gauge, 
click on Perform As Left Cal.  Follow steps 2 through 5 in the Perform a New Calibration in-
structions above.

Alternatively, if the gauge passed the As Received calibration and no adjustments have been 
made to the gauge, FastCalXP can use the As Received calibration for the As Left calibration.  
Click on the Use As Received for As Left button.
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Generate and Print the Certificate
Enter any notes regarding the calibration or modifications made to the gauge in the Calibra-
tion Notes / Modifications box and click on the Save Data button in the Calibration Status box.  
Notes cannot be added after the certificate has been generated.

Create the calibration certificate by clicking on the Generate Certificate button.  FastCalXP will 
create the certificate and open the certificate by running Excel.  Go to the Excel window with 
the current certificate and print the certificate.  

Refer to the Creating Certificates section on page 21 for more information on working with 
certificates.

Calibrating Gauges

This section describes, in detail, many of the concepts referred to in the Quick Start section 
above.

Gauges
FastCalXP refers to the device under test (DUT) as the gauge.  Gauges are the heart of the Fast-
CalXP database.  

Before beginning a calibration, FastCalXP must load the gauge.  Load an existing gauge or use 
the New Gauge Wizard to create a new gauge.  

Refer to the Managing the Database section on page 30 for detailed information about man-
aging gauges with the database manager.
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�	Loading a Gauge
To load an existing gauge, click on Lookup Existing Gauge from the Select Gauge Step column, 
choose Lookup Existing Gauge from the File menu (Ctrl+O) or use the Lookup Gauge button 
on the toolbar. 

Enter the gauge number or select a gauge from the list on the left.  Click OK to load the gauge 
then connect the gauge as described in the GaugeCalXP manual.

�	New Gauge Wizard
The New Gauge wizard is accessed using the Create New Gauge button in the Select Gauge 
window or from the Select Gauge Step column in the main window.  This wizard will take you 
through the generation of a new gauge in four steps:

1	 Select a manufacturer from the pull-down list.  If the manufacturer of the gauge you are 
creating has not been previously entered into the database, click on the Add New Manufac-
turer button. 
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Enter manufacturer information in the Name, Address, Phone, FAX and Web URL text boxes.  
In addition there is space to enter any pertinent notes.  Only the Name field is required.

2	 Select a model from the pull-down list. If the model of the gauge you are creating has not 
been previously entered into the database, click on the Add New Model button.  The Add 
New Model Wizard will step you through the creation of a new model in two steps.

The first page of the wizard allows you to enter the model information.  Enter the Model 
number or name and select the Units of measure from the pull-down list.  Enter the Pressure 
range measured by the model and the increment represented by a Minor graduation on 
the gauge.  When Use custom certificate template is checked, you can override the default 
Excel template defined in the FastCalXP Options dialog. This allows this model to have have 
a unique certificate format. Enter the Cal Interval, in days, that will be used for calibration 
scheduling.
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 Select the Accuracy of the gauge from the pull-down list or specify a percent-of-full-scale 
or custom accuracy.  Refer to the discussion of Models on page 32 in the Managing the 
Database section.

 Use the second page of the New Model Wizard to select the As Received and As Left calibra-
tion Profiles.  If the desired profiles are not listed, click on the Create New Profile button to 
open the Profiles editor.  Refer to the discussion of Test Profiles on page 34.

3	 Select a location from the pull-down list or click on the Add New Location button.

A location is not required.  However, if you are calibrating gauges from several different lo-
cations, the location is another tool for keeping track of gauges.  Enter location information 
in the Name, Address, Contact, Phone, FAX and Email text boxes.  In addition there is space 
to enter any pertinent Notes.
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4	 Enter critical gauge information.

	

The Gauge number is your number for this particular gauge.  This number is required and it 
must be unique among all gauges stored in the database.  

The Serial number is that which is provided by the manufacturer.  The serial number, along 
with model and manufacturer is a second method of uniquely describing the gauge.

The Nickname is not required but may provide another useful description for the gauge.

Calibration due is the date this gauge is next due for calibration.  When a calibration has 
been completed and a certificate created, this date is updated automatically using the cali-
bration interval specified for the model.

When the New Gauge wizard has been completed FastCalXP will automatically load the new 
gauge.  Refer to the Managing the Database section for help with creating a series of gauges 
in one session or with modifying a gauge after it has been created.

�	Calibration Schedule
FastCalXP keeps track of the calibration schedule for all gauges and references in the database.  
To view a list of upcoming calibrations, choose Upcoming Calibrations Report from the View 
menu.

Use the radio buttons to view a list 
of Gauges or a list of References.  
The time span over which FastCalXP 
looks for upcoming calibrations is 
specified under the Config Settings 
tab of the FastCalXP Options.  Refer 
to the discussion of Settings and 
Options on page 24.
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References
A reference is the digital pressure gauge to which the gauge under test is compared during a 
calibration.  FastCalXP is designed to work with Crystal Engineering’s XP2i and Model 30 digital 
pressure gauges connected to the computer’s serial port.

In addition to pressure references, the FastCalXP database can store references used to verify 
ambient conditions at the calibration work station such as ambient air pressure, temperature 
and humidity.  These references can be automatically listed on all certificates.  Refer to the dis-
cussion of Managing References in the in the FastCalXP database on page 37.

�	Reference Selection
Reference selection is perhaps the most important factor in ensuring the most accurate cali-
bration possible.  Many metrology and/or quality systems require that the uncertainty of the 
reference be at least 4 times better than the device being tested, but your metrology require-
ments maybe different.  

Crystal XP2i Digital Test Gauges have an accuracy of ±0.02% of full scale in the lower 20% of 
their ranges and an accuracy of ±0.1% of reading in the remainder of the range.  Model 30  
gauges have an accuracy of ± (0.05% of reading plus 0.005% of full scale).  Both gauges are 
available with a variety of pressure ranges to suit a wide range of needs. 

�	Autodetection
FastCalXP automatically detects Crystal Engineering’s XP2i and Model 30 gauges.  Once the 
gauge and the reference have been mounted on the GaugeCalXP and the serial cable has been 
connected to the reference and the computer’s serial port, the autodetection and calibration 
can proceed.  Refer to the Installation and Setup section for help with configuring your cali-
bration work station.  

To automatically detect a new or previously used reference, turn the reference on and 
click the Perform New As Received Cal button or the Perform As Left Cal button.  FastCalXP will 
take a few seconds to detect the reference.  

When a new reference has been detected it can be added to the database and the current 
calibration certificate information must be entered by the operator.
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Enter the latest calibration certificate number and the date on which that certificate expires.

If the autodetected reference exists in the database, FastCalXP will proceed to the Exercise 
Window or Calibration Window. 

If the reference is not automatically detected refer to the Frequently Asked Questions. 

�	Adding References Manually
References can also be added manually using the Database Manager.  Refer to the Managing 
References on page 37.

Test Profiles
Test profiles are the standardized series of pressure levels used for the calibration of each 
model.  Thus, there is a profile for As Received calibrations and a profile for As Left calibrations 
associated with each model in the database.  In general, profiles begin at zero, ascend to the 
full range of the gauge and descend to zero again.  



Page 14   •   FastCalXP User’s Manual

The second page of the New Model Wizard (accessed via the New Gauge Wizard) is the profile 
selection page.  Use the AR test profile and AL test profile pull-down lists to select a test profile 
for the As Received calibration and a test profile for the As Left calibration.

If the desired profile is not listed, click the Create New Profile button to open the Profiles editor.  
Refer to the discussion of Test Profiles in the Managing the Database section help with the 
Profiles editor.

To edit a profile or add a new profile outside of the New Model Wizard, choose Manage 
Database from the Tools menu and click on the Profiles button to open the Profiles editor.  

To change the profiles that are associated with a model, choose Manage Database from 
the Tools menu and click on the Models button to open the Models editor. 

Select the desired model and choose the desired profiles from the pull-down lists for AR test 
profile and AL test profile.  If a desired profile is not listed, click the Create New Profile button 
to open the Profiles editor.  When the profile has been created, return to the Models editor and 
select the profile from the pull-down list.
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To associate more than one set of profiles to a specific model, create more than one 
model.  Imagine, for example, you have a number of Nuova Fima EN837-1 40 Bar gauges and 
some require a standard nine-point calibration but others, because of the task that they per-
form, require a finer 17-point calibration.  In this case you would create two models, identical 
except that they would have different names, such as EN837-1 Coarse and EN837-1 Fine, and 
different calibration profiles associated with them.

Calibration Strategies
The following discussions provide detailed instructions for getting through a calibration using 
the various modes and approaches available with FastCalXP.  These discussions also provide in-
formation which should help you to establish your own protocol for pressure gauge calibration.

Regardless of the protocol that you settle on, practice will improve your speed and accuracy.  
Take your time and do not hesitate to retrace your steps.  A calibration is only finalized when it 
is saved following completion of the profile.

�	Exercising
Exercising the gauges prior to completing a calibration may improve the accuracy of the 
calibration.  Exercise the gauges by applying the full scale pressure of the gauge one or more 
times.  Refer to the GaugeCalXP Operator Instructions for a more detailed discussion of exercis-
ing the gauges.  

FastCalXP provides an Exercise Window to encourage completion of exercise cycles prior to a 
calibration.  The number of exercise cycles is associated with the profile and specified in the 
Profiles editor.
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To change the number of exercise cycles associated with a profile, choose Manage Da-
tabase  from the Tools menu and click on the Profiles button.  Select the profile of interest and 
click on the Edit button.

Enter the desired number of exercise cycles in the Number of exercise cycles text box. 

�	Matching the Target
Two different approaches can be taken while stepping through a calibration profile: matching 
the gauge to the Target Pressure or matching the reference to the Target Pressure.  
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During a calibration, the Target Pressure is the next profile value and the Reference and Gauge 
pressures are indicated below.  The Gauge value is, by default, the same value as the Target Pres-
sure.  However, the value can be changed by the user to match what is read from the gauge.

To match the reference to the Target Pressure, turn the handle of the GaugeCalXP until Ref-
erence matches the Target Pressure.  Then read the gauge and enter that value in the Gauge. 

To match the gauge to the Target Pressure, read the gauge while turning the handle of the 
GaugeCalXP.  Stop when the gauge reaches the Target Pressure value.  Matching the gauge 
allows for much faster calibration since interpolation is not required to read the gauge and the 
Gauge value does not have to be entered.

�	The Adiabatic Effect
Regardless of what fluid is used in the comparator there will always be a small amount of air re-
maining between the fluid and the gauge sensor.  When pressure is increased in the compara-
tor the air is pressurized and this pressurized gas heats up.  When the pressure stops increasing, 
the gas cools and the pressure in the comparator decreases slightly.  The reverse is true when 
the pressure is reduced in the comparator.  This is called the adiabatic effect.  

The result of the effect for FastCalXP is that the pressure is not immediately stable when a new 
target pressure is reached.  At high pressures, the adiabatic effect can be large.  For example, at 
10,000 PSI the pressure can change by 100 PSI or more as the gas stabilizes thermally.

With FastCalXP, there are two approaches to working with the adiabatic effect.  One approach 
is to adjust the comparator and wait for the pressure to stabilize.  This approach is used in the 
Actual data acquisition mode.  The other approach is to take advantage of the adiabatic effect 
with the Peak data acquisition mode.

Actual or Peak Mode calibration can be selected in the Calibration Window.  Refer to the discus-
sions of the techniques used in Actual Mode Calibration and Peak Mode Calibration on pages 
19 and 20.

To change the default Data Acquisition Mode, choose Options from the Tools menu and 
click on the Calibration Settings tab.  



Page 18   •   FastCalXP User’s Manual

�	Completing a Calibration
When the exercising is complete and the data acquisition mode has been selected, the calibra-
tion measurements can begin.

Even in auto peak mode, the first zero-level measurement must be made manually by pressing 
Enter, clicking on the Next Point button, or pressing the foot switch.  Refer to the discussions 
of Actual Mode Calibration and Peak Mode Calibration on pages 19 and 20 for guidance with 
making measurements.

As the calibration progresses, the gauge will pass or fail at each profile point, or Target Pressure.  
To pass, the Gauge must be equivalent to the Reference within the tolerance range.  The toler-
ance is defined as the accuracy of the gauge at the measured pressure.  The data are displayed 
in a box at the right of the calibration window.

Failed profile points are shaded red.  The gauge must pass at every profile point to pass the 
calibration.  When the specified number of runs has been completed, the Calibration Wizard 
will provide a summary of the results and give the option of displaying the calibration details 
and/or saving the data.
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Save the data, and then press the Finish button, to complete the As Received or As Left calibra-
tion.  Use the Back buttons

  
to return to a previous step or to start over.

Actual Mode Calibration
When FastCalXP is operating in Actual Mode, the Reference value that is taken for any point is 
the pressure reading from the reference at the moment the Next Point button is clicked.  Actual 
Mode is the easiest mode of operation for the novice operator.  However, for the experienced 
operator the calibration process may be slightly slower than in Peak Mode.

�	Standard Actual Mode
It is important to remember that with Actual Mode, you may need to work with one hand on 
the comparator and one hand on the keyboard or mouse. 

To make an Actual Mode measurement, turn the handle of the comparator until the gauge 
(or reference) reaches the Target Pressure.  Adjust the comparator handle until the gauge (or 
reference) has stabilized at the Target Pressure.  

Take care not overshoot the target since the hysteresis can be significant on mechanical 
gauges, causing the gauge to remain high when the pressure has been reduced.  Verify that 
the Gauge value is correct and press Enter or click on the Next Point button.  

If you are matching the Target Pressure to the reference, you will have to enter the reading 
from the gauge in the Gauge box before you press Enter.

To re-measure a profile step, click on Previous Point and adjust the comparator to reach the 
target again.
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�	Using the Foot Switch
The optional foot switch will significantly speed operation in Actual Mode since it enables 
hands-free acceptance of a measurement.  In most cases, the foot switch will provide the fast-
est calibration method, even over Auto Peak Mode.  In all calibration modes, the foot switch 
operates as the Next Point button.

To make an Actual Mode measurement with the foot switch, turn the handle of the com-
parator until the gauge reaches the Target Pressure.  Adjust the comparator handle until the 
gauge has stabilized at the Target Pressure and push on the foot switch.

Peak Mode Calibration
Peak Mode calibration uses FastCalXP’s peak detection capability to take advantage of adia-
batic pressure changes.  In Peak Mode, the Reference reading is the largest (or smallest when 
descending) value recorded by the reference since the peaks were last cleared.  FastCalXP will 
determine automatically whether you are ascending or descending in order to correctly pick a 
maximum or minimum for the “Peak.”

�	Standard Peak Mode
For a moderately experienced operator, standard Peak Mode has the potential of being slightly 
faster than Actual Mode since it is not necessary to hold the comparator at the target pressure 
while it stabilizes.

To make a standard peak mode measurement, turn the handle of the comparator smooth-
ly and steadily until the gauge (or reference) reads the Target Pressure value.  Verify that the 
Gauge pressure is correct and press Enter, click the Next Step button or push on the foot switch.  

If you are matching the Target Pressure to the reference, you will have to enter the reading 
from the gauge in the Gauge box before you press Enter.

If you overshot the Target Pressure but did not press Enter, back off from the target, click Clear 
Peaks and approach the target again.

To re-measure a profile step, turn the handle of the comparator to back off from the last 
pressure step, click Previous Point and approach the target again.  

To use the foot switch in standard peak mode, follow the instructions above for making 
peak mode measurements using the foot switch to engage the Next Point button.  The foot 
switch operates as the Next Point button.

�	Auto Peak Detection
Auto Peak Detection mode provides the fastest way of performing a calibration for the expe-
rienced operator.  With Auto Peak turned on, FastCalXP will automatically detect a peak in the 
ascending portion, or valley in the descending portion of the profile, record the value reached 
at the peak or valley and advance to the next profile point.  
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Auto Peak mode is set up specifically for calibrations where the gauge is being matched to 
the Target Pressure value.  The mode will not provide an accurate calibration if the reference is 
matched to the Target Pressure since the Target Pressure value is automatically taken for the 
Gauge.

To turn on Auto Peak mode, choose Options from the Tools menu and click on the Calibra-
tion Settings tab.

Select Peak calibration method and check the Use Auto Peak Detection box.  

You will also have the option of specifying the number of readings to look at in determining 
if a peak has been reached.  The default is five but the optimal number will depend on the 
individual operator’s speed and will likely be determined experimentally.  A number that is 
too high will cause a delay in the detection of the peak and a number that is too low will cause 
FastCalXP to detect undesired peaks.  FastCalXP gets a reading about once every second from a 
Model 30 gauge and about twice every second from an XP2i.

To make an Auto Peak mode measurement, turn the handle of the comparator smoothly 
and steadily until the gauge reads the Target Pressure value.  Stop, wait for the program to 
beep and record the data point. Then begin to turn the handle again for the next profile step.

To clear the last profile step in Auto Peak mode, turn the handle of the comparator to back 
off from the last pressure step, click Previous Point and approach the target again.  

Creating Certificates

Certificate Basics
Certificates are meant to be enduring documents that record the calibration of gauges.  They 
are Excel XLS format documents with one or more worksheets each.  For the most part, certifi-
cate data cannot be edited in the database once the certificate has been created, although the 
Excel worksheets can be password protected to enhance the security of the data.
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When As Received and As Left calibrations have been completed the certificate can be created, 
viewed and printed.  Since all of the data for the certificate are retained in the database, the 
certificate can be re-created at any time.

To add notes to a calibration, type the notes into the Calibration Notes / Modifications box 
in the lower right of the main window and click on the Save Data button in the Calibration 
Status box.  Notes cannot be added after the certificate has been generated.

To create a certificate from loaded data, click the Generate Certificate button. FastCalXP 
will create the certificate and open it in Excel.  The certificate can then be viewed and printed.

Excel Templates
One of FastCalXP’s greatest strengths is the ability to create custom certificates using an Excel 
template. This allows the certificate to be fully customized, including the use of graphics and 
foreign languages. Each model in the database can have a different template, allowing for the 
greatest flexibility in generating certificates.
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FastCalXP creates certificates by filling an Excel template with the appropriate stored data, 
replacing tags that identify the fields that are to be filled.  FastCalXP does search-and-replace 
operations in each worksheet in the template that includes a certificate number tag.  Refer 
to Appendix B: Excel Template Tags for a list of tags that can be included in the certificate 
templates. 

Tags are organized in a hierarchy so that the software will not search for tags that are lower in 
the hierarchy unless it has already found associated upper level tags.  For example, reference 
fields will not be filled unless there is a reference number tag associated with those fields.  Bold 
tags listed in Appendix B are necessary tags in the tag group with which they are associated. 

The number sign that is included in some of the tags is a placeholder indicating that numbering 
is required.  FastCalXP will not add fields to a template when it is creating a certificate but it will 
empty all unused fields.  For example, if the template only contains tags for 5 data points, but 
the profile contains 10 data points, only the first 5 data points will be placed in the certificate.

Worksheets within the template can be password protected if the Excel password is set in the 
Options dialog (see Settings and Options on page 24). Every sheet in the workbook will be 
password protected, even if no tags exist on a sheet. 

Templates are associated with models.  A standard template is provided with the FastCalXP 
software.  This template can be copied and edited to create any number of different templates.  
Refer to Excel documentation for help with creating Excel templates.  

To create a new template, copy the provided template, rename the copy and edit the new 
template in Excel.  Make sure there are enough fields and tags for the number of data points to 
be collected. 

To specify the default template, choose Options from the Tools menu and click on the Config 
Settings tab.  Browse to find the desired template.  Take care in making this change, as this will 
affect all models that do not have the checkbox Use custom certificate template checked. 

To change the template that is associated with a model for models that have a custom 
template selected, choose Manage Database from the Tools menu and click on Models.  Se-
lect the desired model, click Edit and use the Browse button to find the desired template. 

Viewing Certificate Data
Before creating a certificate, you may wish to look at the data from the current calibrations or 
from an older certificate.

To view data from a current or previous certificate, open the Excel certificate or load the 
data into FastCalXP.  
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There are two ways to load the data for a specific certificate. Choose Load Certificate Data from 
the File menu to select certificate data for the gauge that is currently loaded.  Alternatively, if 
you know the certificate number or gauge number that you are looking for, choose Lookup 
Certificate from the Tools menu and enter the number.

Once the data is loaded, click the View Detailed Data button located next to the summary at 
the bottom of the main window.  

You may need to use the scroll bars to view the entire dataset.

Settings and Options

Options
FastCalXP settings can be modified by choosing Options from the Tools menu.  By default, this 
menu item not available when a technician is logged on.  Log on as an administrative operator 
to access Options.  

The FastCalXP Options dialog box allows configuration in four areas available via four tabs.
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�	Config Settings
The Config Settings tab provides access to system defaults and certificate settings.  

The Default certificate template is the calibration certificate template that will be used, by 
default, for creating certificates. This can be overridden by checking Use custom certificate 
template in the model configuration. Refer to the Creating Certificates section for a discussion 
on creating and editing certificate templates. Refer to Models in the Managing the Database 
section on selecting alternate templates.

The calibration certificates created by FastCalXP will be saved in the directory specified in Save 
certificates to.  This directory is set the first time the software is run after installation or when a 
new database is created and can be changed here using the Browse button.

The Certificate naming template is used by FastCalXP to name the calibration certificates.  In 
general, certificates are numbered with the Next certificate number incrementing automatical-
ly each time a certificate is created.  Use number signs (#’s) in the Certificate naming template 
to define the number of digits to be used.

The Calibration Representative and the Quality Representative must be listed users and can be 
selected using the pull-down lists.  In the certificate template provided with the software these 
names will be listed, with signature lines, on the first page of each certificate.
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The calibration interval and pressure unit specified here will be used as the defaults for all 
newly created models.  

The Multiple Database Support checkbox enables the management of multiple databases. For 
help with multiple databases, refer to Multiple Database Support in the Managing the Data-
base section on page 30. 

By default, FastCalXP will check for the default database when the program starts.  If you do 
not want this to happen uncheck the Check DSN on startup box.  For help with specifying the 
default database, refer to the Managing the Database section on page 30. 

Specify how far in advance you wish to be warned of upcoming calibrations in the Upcoming 
Calibrations Report by adjusting the number of days in the Cal due report window.  

The XP2/Model 30 serial port specifies which port FastCalXP will look at to find the Crystal 
reference.  Typically, this is set to ‘Auto’, and FastCalXP will automatically detect the serial port to 
which the gauge is connected. Change to the specific serial port if your configuration requires it. 

The Language selection will list all available translations for FastCalXP that have been installed. 
Language packs are available through your local distributor as well as online at  
http://www.crystalengineering.net. After changing the language, you will need to restart  
FastCalXP before the change will take affect.

The Use custom audio alert checkbox allows you to change the sound that is played when 
FastCalXP automatically advances to the next pressure point during calibration.

�	Calibration Settings
The Calibration Settings define the default Calibration Method.  
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The Actual method uses the pressure reading from the reference at the moment the Next Point 
button is clicked.  

The Peak method uses the peak reading from the reference immediately prior to the moment 
the Next Point button is clicked.  The number of readings used to identify a peak can be speci-
fied here.

If Auto Peak Detection is enabled, FastCalXP will automatically advance to the Next Point when 
a peak is detected.  

If the gauge and the reference do not sit at the same height, a Head correction can be applied.  
Enter a correction to be added to the reference pressure, or use the Correction calculator to 
calculate a correction given the specific conditions of the calibration.  Refer to the discussion of 
the Head Correction Calculator on page 29.

�	Login Options
The Login Options allow the administrator to enable the login feature of FastCalXP.  The login 
feature allows control over who uses the software.  In addition, the feature provides a record in 
the database of which user performed each calibration and of which user created each certifi-
cate.  The Login Options tab is not available to technicians.

Select No Login to disable the user login feature.  

Select Automatic Login to log the specified user in each time the program is run.  

Select Require Login to require any user to enter a valid user name and password.  If a valid 
user name and password is not specified, FastCalXP will not run.

When a user is logged in, the name of the user is displayed in the Status Bar at the bottom of 
the FastCalXP main window.  The privileges of the user will be determined by the user type 
(administrator or technician) and the Security Settings as discussed below.
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To log in when Login is disabled choose 
Login from the File menu.  The login dialog 
will be displayed.  Enter your Username 
and Password.

�	Security Settings
The Security Settings allow the administrator to set the privileges of technicians.  The Security 
Settings tab is not available to technicians.  

To allow technicians access to the Options dialog with the Config Settings and Calibra-
tion Settings, check the Grant technicians access box.

To allow technicians to edit portions of the database, check the boxes next to the desired 
table names.  When Manage Database is selected from the Tools menu, the technician will have 
access only to the checked tables.  All other buttons will be grayed out.  

The Password Protect Certificates setting enables you to set a password to each sheet of the 
Excel calibration certificate to prevent modification after the certificate has been generated. All 
worksheets within the workbook will be protected with this password.

Where Settings Are Stored
While most settings and options are stored within the database, some settings, such as the se-
rial port, are stored separate from the database and apply to all databases. If you are only work-
ing with a single database, you can ignore this section as it will have no affect on you. However, 
if you use multiple database support, it is important to understand that some settings are 
unique to the database you are using, while others only need to be set once for all databases. 
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The following settings apply to all databases and only need to be set once: 

Options dialog, Config Settings tab.
•	 Multiple database support 

•	 Check DSN on startup 

•	 Language selection 

•	 XP2/Model 30 serial port

Options dialog, Calibration Settings tab 

•	 Calibration method 

•	 Peak detection settings 

•	 Head correction

Options dialog, Security Settings tab 

•	 All security settings except certificate password.

Change Database dialog.
•	 Choosing database on startup setting

All other settings are stored within the database. This means that when you change any set-
ting not included in the list above, it affects only the current database. If you want to change a 
setting not in the list above, but have it affect all of your databases, you will need to switch to 
each database and make the change.

Head Correction Calculator
The Head Correction Calculator is accessed via a button under the Calibration Settings tab.
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The calculator uses Fluid density, Gravity and Height change to calculate a correction that is 
added to the pressure measured by the reference.  

Four standard fluid densities, for Isopropyl Alcohol at 25°C, Pure Water at 4°C, Pure Water at 20°C 
and Air at 15°C and sea level, can be applied using the buttons in the Head Correction box.

The local gravity can be estimated using the local Latitude and the altitude above Mean sea 
level.  Enter these values and click on the Calculate Gravity button.  The calculated gravity will 
automatically be entered into the Gravity field in the Head Correction box.

When the appropriate parameters are entered, click on the Calculate Head Correction button 
to display the calculated Head Correction.  Click OK to insert the correction into the head cor-
rection box in the Calibration Settings.

Managing the Database

The FastCalXP database stores all of the information entered into or acquired by the program.  
The database is a Microsoft Access format database that is accessible from within FastCalXP.  All 
user-entered data related to Gauges, Units, References and Users can be edited by an adminis-
trator.  Administrator-defined privileges may also permit access to some portions of the data-
base by a technician.  Refer to the discussion of Security Settings on page 28 in the Settings 
and Options section.

Calibration data collected by FastCalXP cannot be edited by the user.  This data can be viewed 
and printed in the form of certificates only.

To modify or add to the editable portions of the database, choose Manage Database from 
the Tools menu.  For management purposes, the database consists of eight tables which can 
be accessed via the buttons in the Database Manager.  
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To change the Current Database, click the Change button in the lower right corner.  If Mul-
tiple Database Support has been enabled in the Options dialog, you will be taken to the Select 
FastCalXP Database dialog (see below). Otherwise, use the Open dialog to browse your directo-
ries to find the .MDB file that you wish to load.  

To add to or edit a table, click on the button for that table. Each dialog, or table editor, in-
cludes a list of items on the left, item details in the center which can be edited and action but-
tons on the right. A checkbox at the bottom left allows you to display hidden items in the list.  A 
checkbox at the bottom center allows you to specify whether or not the current item is hidden.

To add a new item, click on the New button and enter the details in the center box.

To edit an existing item, select the item from the list on the left, click the Edit button and 
modify the details as desired.

To end an editing session, click on one of the action buttons on the right.  

OK will save the changes and exit the editor.  Save will save 
the changes but leave the editor open.  Cancel Edit will 
abandon the changes and leave the editor open.

Gauges
The Gauges editor allows access to the data associated with all gauges in the database.  The 
Gauge Details in the center of the editor includes seven fields containing identifying informa-
tion about the currently selected gauge.  Most of these fields are required.
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The Gauge number is your number for this particular gauge.  This number must be unique 
among all gauges stored in the database.  

Use the pull-down lists to select a Manufacturer and a Model from those stored in the data-
base.  If the desired Manufacturer and Model are not listed, click on the Create New Model 
button to open the Models editor.

The Serial number is that which is provided by the manufacturer.  The serial number, along 
with model and manufacturer is a second method of uniquely describing the gauge.  

The Nickname is not required but may provide another useful description for the gauge.  The 
Location is also not required.  If you wish to enter a location but do not see the desired location 
listed, click on the Create New Location button to open the Locations editor.

Calibration due is the date this gauge is next due for calibration.  When a calibration has been 
completed and a certificate created, this date is updated automatically using the calibration 
interval specified for the model.

Models
The Models editor allows access to the data associated with all models stored in the database.  
The Model Details in the center of the editor must be completely specified for each model.  
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The Model name is normally simply the name of the model provided by the manufacturer.  
However, if you wish use different test profiles on different groups of a single manufacturer’s 
model, you may need to add a modifier to the model name that will help you recognize which 
test profiles will be used for calibration.

Select the Manufacturer and the Units of measure for this model from the pull-down lists.  
Specify the Pressure range and the value associated with each tic, or Minor graduation, on the 
gauge.  The minor graduation value defines the resolution of the gauge.

From the pull-down lists, select test profiles for As Received (AR) and As Left (AL) calibrations.  
Specify the number of runs through each profile, or Qty.  If the desired profile is not listed, click 
on Create New Profile to open the Profiles editor.

When Use custom certificate template is checked, you can override the default Excel template 
defined in the Options dialog. This allows different manufacturers or models to have unique 
certificate formats. 

There are three ways to define the Accuracy of the model.  Many gauges will have an ASME or 
ISO/IEC grade which can be selected from the pull-down list.  If the accuracy is not listed, you 
may be able to simply enter a % of span accuracy.

Alternatively, define a Custom accuracy by specifying a series of pressure ranges and accura-
cies associated with those ranges.  Click the Add button to include a range and accuracy in the 
specification.  When the accuracy is fully specified, click OK.
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Manufacturers
The Manufacturers editor allows access to the information about each manufacturer stored in 
the database.

Only the Name is required.  The Address, Phone, Fax and Web address will help with contacting 
the manufacturer if necessary.  In addition there is space to enter any pertinent Notes.

Test Profiles
The Profiles editor provides ac-
cess to all test profiles stored in 
the database.

The Profile Details box is also 
available for creating a new pro-
file when a new model is created 
using the New Gauge Wizard.
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When creating a new profile, it will help to make the Name descriptive and specific, particularly 
if you will be using several similar profiles for different models.  Be sure to specify the correct 
Units of measure.  A non-zero Number of exercise cycles, will remind the operator to exercise 
the gauges before beginning any calibration that uses this profile.

To create a uniform series of pressure points, click on Ascending/descending points. Any 
current list of pressures will be cleared. Specify the minimum and maximum range of the pro-
file and the number ascending and descending points. The Pressure(s) list will be filled auto-
matically.

To create a non-uniform series, click on Custom.  Any points that are already listed will re-
main.  Select a point to delete or move or click New to add a point.

The entered pressure value will be added to the list.

Click Move Down or Move Up to position the selected point in the profile.  Double-click on a 
point or click on the Delete button to remove the selected point.

When the desired profile is achieved, the profile can be saved for use with any model.
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Locations
The Locations editor allows access to the information about each location stored in the data-
base.

Only the Name is required to store and use a location in the database.  The Address, Contact 
name, Phone, Fax and Email address will help with contacting the location if necessary.  There 
is also a field for any Notes.

Pressure Units
Units are specified for each model and that model’s associated profiles.  The FastCalXP software 
includes 13 different defined system units.  The names of these units and their PSI conversion 
factors are listed in Appendix A.  These system units cannot be modified.

The Units editor provides access to all custom units stored in the database.

If a model has units not included in the units list, add the unit first, then add the model.

Specify the Name of the unit and the PSI conversion factor.
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References
The References editor provides access to all references stored in the database.  

Most references are Crystal digital pressure gauges automatically detected by FastCalXP.  Refer 
to the Autodetection discussion on page 12.  These references can, however, be added manu-
ally and will always require updating of the calibration information each time the reference is 
calibrated.

To add a Crystal reference manually, select the Type from the pull-down list.  Then fill in the 
serial number (SN), the Cal Cert number and the date that the certificate Expires.  The informa-
tion that will require editing for these references will be calibration certificate information.

Any instrument used to measure ambient conditions in the calibration laboratory, such as 
temperature, humidity and barometric pressure, can also be considered a reference.  These 
references are used to verify that ambient conditions are within specified ranges.  If these refer-
ences are included in the database, it may be desirable to list them in each certificate that is 
generated.

To add a reference for ambient conditions, enter the Manufacturer, Model number and 
serial number (SN).  Enter the most recent Cal Cert number and the date that the certificate 
Expires.  Enter a representation of the Accuracy of the instrument.  Click the Include in all certs 
checkbox to list the reference in every certificate that is generated.
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Users
The Users editor provides the administrator access to the login information for all users of the 
FastCalXP software.

The Login name and Password are used in the login dialog box.  The Full name of the user is 
attached to the saved calibrations and certificates completed by the user.  The Authorization of 
Technician or Administrator defines the privileges of the user.  There is also a field for any Notes.

Refer to discussions of login options and security settings in the Options and Settings section 
above.

Multiple Database Support
FastCalXP  is designed to work with Access Databases for data storage. By enabling Multiple 
database support in the Options dialog, it is possible to create and manage multiple databases 
directly from FastCalXP. While only one database can be open at a time, this feature simplifies 
the process of switching between databases.

It is important to understand that you will not be able to share any data between databases, 
including records of references, gauges, models, etc. In addition, many settings, such as the 
default template, are stored within the database (see Where Settings Are Stored on page 28, 
for more details). Be sure you understand the implications of using multiple databases before 
enabling this feature. For example, if you are using the same references in multiple databases, 
you will have duplicate entries in each database, and when the gauge is recalibrated, the new 
calibration date will need to be changed in every database that uses the reference.

If multiple database support is enabled, when the Change button is clicked in the Manage 
Database dialog, the following dialog appears:
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To add a database to the list of available databases, simply click the Add Existing Data-
base button. Browse to the database and click Open. After selecting the database, you will be 
asked for a name, which will be displayed along with the database file name. This name is also 
displayed in the title bar of the application to indicate which database is in use.

Similarly, to create a new, blank database, click the Create New Database button. Browse 
to where you would like to store the database and provide a name. 

The Edit and Remove buttons allow you to change settings for or remove a database entry, 
respectively.

To select the database you want to use, simply click on the database entry and then click 
the Use button. If you are changing the database file after FastCalXP has started, you will need 
to exit and restart the program before the database change will go into effect.

To have this dialog appear every time FastCalXP starts, click the Open this dialog every 
time FastCalXP starts checkbox. This will allow you to select the database during startup of 
FastCalXP without needing to change it from within the Manage Database dialog.
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Menus and Windows

Command Summary
Following is a list of all commands available in the FastCalXP menu structure.

�	File
Create New Gauge. . . . . . . . . . . . . . .              Use the New Gauge Wizard to create a new gauge.

Lookup Existing Gauge . . . . . . . . . .         Load a gauge.

Load Previous Data. . . . . . . . . . . . . .             Load existing calibration data for the loaded gauge.

Load Certificate Data. . . . . . . . . . . . .            Load data for an existing certificate associated with the 
loaded gauge.

Save. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            Save pressure calibration data that has not yet been saved.

Generate Certificate . . . . . . . . . . . . .            Create an Excel format certificate from the currently 
loaded data.

Login. . . . . . . . . . . . . . . . . . . . . . . . . . . .                           Enter a username and password.  Change the user.

Exit. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             Close FastCalXP

�	View
Detailed Data. . . . . . . . . . . . . . . . . . . .                   Display a table of the currently loaded calibration data.

Certificate. . . . . . . . . . . . . . . . . . . . . . .                      View the currently loaded certificate.

Upcoming Calibrations Report. . .  Display a table showing calibrations that are due.

Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . .                         View/hide the toolbar.

Status Bar . . . . . . . . . . . . . . . . . . . . . . .                      View/hide the status bar.

�	Tools
Look up Certificate. . . . . . . . . . . . . . .              Pull up a certificate by number.

Manage Database . . . . . . . . . . . . . . .              Open the database manager.

Options . . . . . . . . . . . . . . . . . . . . . . . . .                        View the settings and options dialog.

�	Help
Help Topics. . . . . . . . . . . . . . . . . . . . . .                     Open the FastCalXP PDF manual.

About FastCalXP. . . . . . . . . . . . . . . . .                Display information about this version of FastCalXP
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Main Window
The FastCalXP Main Window provides a graphical representation of the program flow and the 
current status of the program and the calibration process.

Calibration Window
The FastCalXP Calibration Window provides a straightforward user interface for proceeding 
with a single calibration.
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Frequently Asked Questions

Gauges
Why doesn’t the gauge that I am looking for show up on the list in the Load 
Gauge window?
It is marked as hidden.  Click the box that says Show hidden gauges.  To un-hide the gauge 
edit the gauge with the Database Manager.

Why doesn’t a model that I have already entered show up in the pull-down menu 
in the New Gauge Wizard?
If you know that you have the correct manufacturer for the model, you may have entered 
the model under the wrong manufacturer originally.  Use the Database Manager to see if 
the model is listed.  If it is listed, verify and correct the manufacturer that is associated with 
the model.

References
Why doesn’t the Calibration Wizard detect my reference?
Be sure that the serial cable connectors are properly seated and that the reference has 
been turned on.  If the software still does not detect the reference, check the number of 
the serial port on the computer.  choose Options from the Tools menu.

On the Config Settings tab, verify that the XP2/Model 30 serial port is the same as that to 
which the serial cable is connected.

Why isn’t the peak value on my computer the same as the peak value on my 
XP2i?
Peak Mode operation does not use the XP2i’s peak feature.  Instead, the peak is detected 
within the FastCalXP software.  

I am using a Model 30 for a reference. Can I still use Peak Mode?
Yes. The peaks are detected within the FastCalXP software so you can use a gauge that 
does not have its own peak feature.  

Units
Why don’t I see anything in the Units portion of the Database Manager?
Only units added by an operator can be edited with the Database Manager so only these 
units are listed.  Refer to the list of FastCalXP Pressure Units in Appendix A to find conver-
sions to PSI.



FastCalXP User’s Manual   •   Page 43

C R Y S T A Le n g i n e e r i n g
c o r p o r a t i o n

Peak Mode
I have selected Peak Mode.  Why doesn’t my computer beep when I stop at a 
target?
Auto Peak detection is not turned on.  Choose Options from the Tools menu, click on the 
Calibration Settings tab and click to check the Auto Peak Detection box.

The Auto Peak box has been checked in the Calibration Settings. Why isn’t my 
computer beeping?
Your computer’s speaker may be muted or the volume may be very low.  Check the speaker 
volume and try again.

Pressure Calibration Terms

Actual Mode . . .    The data acquisition mode that takes the current reading from the reference 
at the desired moment of measurement.

As Left . . . . . . . . .          The state of the gauge after it has had calibration adjustments made.

As Received. . . .     The state of the gauge when it is initially measured.

Comparator. . . .     A device used to apply equal pressure to the gauge and reference.

Gauge . . . . . . . . .          The instrument that is being calibrated, or the device under test (DUT).

GaugeCalXP. . . .     Crystal Engineering’s pressure comparator.

Model 30. . . . . . .        A Crystal Engineering digital pressure gauge.

Peak Mode. . . . .      The data acquisition mode that takes the most recent peak (or valley) from the 
reference at the desired moment of measurement.

Reference. . . . . .       The instrument to which the DUT is compared during a calibration.  Also, any 
instrument used to measure ambient conditions during the calibration.

XP2i. . . . . . . . . . . .             A Crystal Engineering digital pressure gauge.

Appendix A: FastCalXP Pressure Units

FastCalXP uses the following standard units and associated conversion factors.  All conversion 
factors use a gravity constant of 9.80665 m/sec2.

1.0000 . . . . . . . .         PSI per PSI 

27.68059969 . .   inch H2O @ 4°C (39.2°F) per PSI

27.70699859 . .   inch H2O @ 60°F (15.6°C) per PSI

27.72920132 . .   inch H2O @ 68°F (20°C) per PSI

703.087. . . . . . .        mm H2O @ 4°C (39.2°F) per PSI

70.3087. . . . . . .        cm H2O @ 4°C (39.2°F) per PSI

0.070307. . . . . .       kgf/cm 2 per PSI

2.03602. . . . . . .        inch Hg @ 0°C (32°F) per PSI 

51.7149. . . . . . .        mm Hg @ 0°C (32°F) per PSI 

6.8948 . . . . . . . .         kPa per PSI

0.0068948. . . . .      MPa per PSI

0.068948. . . . . .       bar per PSI

68.948 . . . . . . . .         mbar per PSI
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Appendix B: Excel Template Tags

Following is a list of Excel template tags used by FastCalXP to create certificates using search-
and-replace operations.

Tags are always included within chevrons (e.g., <tag>) and they can occur anywhere within 
a template worksheet.  However, FastCalXP will only search and replace in a worksheet that 
includes the <CertNum> tag.  Bold tags must be present for FastCalXP to fill fields defined by 
other tags in the same group. 

Tags marked “Saved in Cert” are values that will remain constant within a certificate once the 
certificate is created, even if the information in the database is changed at a later date.  For 
example, the gauge number for a given certificate will not change even if it is changed in the 
database after the certificate is created.  Since the system can recreate the certificate at a later 
date, saved fields provide an assurance that the major elements within a certificate will not be 
modified after the certificate is created.

Some of the tags have a number sign (#) as part of the tag.  This is to support multiple values of 
the same type (i.e., multiple references or data points) to be included in the certificate.  For ex-
ample, to have a certificate that has ten indicated pressure points for run 1, you would need to 
include <ARRun1Point1Indicated> through <ARRun1Point10Indicated> tags in the template.

Tag Name Saved
in Cert

Description

As Left Profile
<ALProfileActive> 0 = active, 1 = inactive (hidden)
<ALProfileExerciseCount> Number of exercises
<ALProfilePressureHigh> Yes Maximum pressure in profile
<ALProfilePressureLow> Yes Minimum pressure in profile
<ALProfileID> Database ID number of profile
<ALProfileName> Name of profile

As Received Profile
<ARProfileActive> 0 = active, 1 = inactive (hidden)
<ARProfileExerciseCount> Number of exercises
<ARProfilePressureHigh> Yes Maximum pressure in profile
<ARProfilePressureLow> Yes Minimum pressure in profile
<ARProfileID> Database ID number of profile
<ARProfileName> Name of profile

Gauge
<GaugeActive> 0 = active, 1 = inactive (hidden)
<GaugeID> Database ID number of gauge
<GaugeNickname> Gauge nickname
<GaugeNumber> Yes Gauge number
<GaugeSerialNumber> Yes Gauge serial number
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Tag Name Saved
in Cert

Description

Calibration Rep
<CalRepFullname> Yes Calibration rep full name

Certificate
<CertActive> Yes 0 = active, 1 = inactive (hidden)
<CertALCondition> Yes Pass/fail condition: 0 = no data taken, 1 = failed, 

2 = passed
<CertARCondition> Yes Pass/fail condition: 0 = no data taken, 1 = failed, 

2 = passed
<CertGaugeModifications> Yes Memo field of modifications to gauge
<CertEffectiveOn> Yes Effective date of cert (when cert was created)
<CertExpiresOn> Yes Cert expiraton date = CertEffectiveOn + 

ModelCertPeriod
<CertNum> Yes Certificate number

Globals
<GlobalsCalMode> Calibration mode
<GlobalsDefaultCertTemplate> Default certificate
<GlobalsHeadCorrection> Head correction

Location
<LocationActive> 0 = active, 1 = inactive (hidden)
<LocationAddress> Location address
<LocationContact> Location contact
<LocationEMail> Location email
<LocationFAX> Location FAX
<LocationID> Location database ID
<LocationName> Location name
<LocationNotes> Location notes
<LocationPhone> Location phone

Manufacturer
<MfgActive> 0 = active, 1 = inactive (hidden)
<MfgAddress> Manufacturer address
<MfgFAX> Manufacturer FAX
<MfgID> Manufacturer database ID
<MfgName> Yes Manufacturer name
<MfgNotes> Manufacturer notes
<MfgPhone> Manufacturer phone
<MfgURL> Manufacturer URL
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Tag Name Saved
in Cert

Description

Model
<ModelActive> 0 = active, 1 = inactive (hidden)
<ModelALProfileID> Model AL profile database ID
<ModelALQuantity> Model AL profile quantity
<ModelARProfileID> Model AR profile database ID
<ModelARQuantity> Model AR profile quantity
<ModelCertPeriod> Model cert period
<ModelCertTemplate> Model cert template
<ModelID> Model database ID
<ModelName> Yes Model name
<ModelRangeMax> Model maximum pressure
<ModelRangeMin> Model minimum pressure
<ModelResolution> Model pressure resolution
<ModelType> Model type
<ModelUnitID> Model Unit database ID

Operator The Operator User is the account that is logged 
in when the cert was created.

<OperatorActive> 0 = active, 1 = inactive (hidden)
<OperatorAuthLevel> Operator authorization level
<OperatorFullname> Operator full name
<OperatorNotes> Operator notes
<OperatorUserID> Operator database ID
<OperatorUsername> Operator login username

Quality Representative
<QualRepFullname> Yes Quality rep full name

Session The session is the top level object that contains 
everything else about the calibration.

<SessionDate> Session date (last time data saved)
<SessionID> Session database ID

Session User The Session User is the account that did the 
calibrations

<SessionUserActive> 0 = active, 1 = inactive (hidden)
<SessionUserAuthLevel> Session user authorization level
<SessionUserFullname> Session user full name
<SessionUserNotes> Session user notes
<SessionUserUserID> Session user database ID
<SessionUserUsername> Session user login username

Units * For UnitID < 1000, all fields are saved in 
certtificate as they are built-in units

<UnitActive> * 0 = active, 1 = inactive (hidden)
<UnitID> * Unit database ID
<UnitName> * Unit name
<UnitPSIConversion> * Unit PSI conversion factor
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Tag Name Saved
in Cert

Description

References
<Reference#SN> Yes Reference serial number
<Reference#ID> Yes Reference database ID
<Reference#Manufacturer> Yes Reference manufacturer
<Reference#Model> Yes Reference model
<Reference#CertNumber> Yes Reference certificate number
<Reference#CertExpires> Yes Reference certificate expiration
<Reference#AccuracyStatement> Yes Reference accuracy statement

Conditions
<ALCond#Pressure> Yes As Left pressure set point
<ARCond#Pressure> Yes As Received pressure set point

Data
<ARRun#Point#Indicated> Yes AR indicated
<ARRun#Point#Setpoint> Yes AR set point
<ARRun#Point#Applied> Yes AR applied
<ARRun#Point#Error> Yes AR error
<ARRun#Point#Tolerance> Yes AR tolerance
<ARRun#Point#Temperature> Yes AR temperature
<ARRun#Point#Passed> Yes AR point passed

<ALRun#Point#Indicated> Yes AL indicated
<ALRun#Point#Setpoint> Yes AL set point
<ALRun#Point#Applied> Yes AL applied
<ALRun#Point#Error> Yes AL error
<ALRun#Point#Tolerance> Yes AL tolerance
<ALRun#Point#Temperature> Yes AL temperature
<ALRun#Point#Passed> Yes AL point passed
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